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1. Introduction 
The FIVB Vis application is the complete Volleyball management system which allows the FIVB, 

National Federations and Event Organisers to manage the management of and participation in FIVB, 

Continental, Zonal and National events. 

Specific functionalities include: 

- Registration of events 

- Registration of teams 

- Registration of referees 

- Selection of competition format 

- Defining match schedules 

- Allocating referees to matches 

- Logging match result and statistics 

- Generating reports 

- Upload press release of an event (coming soon) 

- Upload photos of an event (coming soon) 

When opening the application the home screen will feature the ‘Main´ tab providing access to 

‘Volley’, ‘Beach’ and ‘Players’ icon within the main  

As the FIVB VIS application is purpose built and owned by the FIVB, there will be upgrades of the 

application in the future. Please keep an eye out for this and also for an update in the manual. 

 

 

 



FIVB VIS Volleyball Information System 

 

5 
 

2. Set Up 
 

2.1 Download 
To download the FIVB VIS application, please enter the following URL into a search engine or URL 

bar: 

www.fivb.org/vis2009/downloadapplication.asmx?Code=VIS 

The software will download to your computer via a zip file. Locate this zip file and install the 

application onto your computer following the onscreen instructions. 

Please note; This is a Windows based application and therefor it is not compatible to Macintosh or 

Lunix based operating systems.  

2.2 Installation  
Once you have downloaded the software and located the zip file (this should be accessible in the 

downloads folder of your computer), follow the next steps to install the software: 

 Open the zip folder 

 Double click on the file ‘VIS-Setup-15.4.27.818.exe’ (the 3 last digits represents the build 

number of the application and is subject to change). 

 

 

 

 

 

 

 Select yes from the ‘Warning’ pop up 

 Select a language from the ‘VIS Setup’ pop up 

 Select a storage space on your computer to locate the FIVB VIS application  

(A default location will be selected already. If you wish to keep this move onto the 

next step. If you wish to change it then select the trigger button to the right of the 

file name and select a storage space). 

 Select a shortcut for the application on your ‘Desktop’ or/and ‘Start Menu Programs folder’ 

and click ‘Install’ 

 Select ‘I agree to the License terms and conditions’ and select ‘Next’ 

 Select ‘Yes’ from the ‘User Account Control’ pop up window 

 Then select ‘Run’ to open the application or ‘Finish’ to complete the installation 

Please note; The FIVB VIS Application will require 34 MB storage on your computer.  

http://www.fivb.org/vis2009/downloadapplication.asmx?Code=VIS
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2.3 Signing In 
Open the application from your desktop or file location and select ‘Sign In’ from the top right hand 

corner of the page. 

A pop up box as seen below will appear. Continue to fill out the credentials according to your unique 

username and password which will be provided for you by the FIVB VIS administrator.  

 

 

 

 

 

 

 

The following ‘Options’ are available when logging in; 

 Don’t remember anything on this computer 

 Remember my username 

 Remember my username and password 

 Automatically sign in at application start up 

Please Note: For security reasons, the final two options available from the sign in function are not 

recommended if you are sharing a computer or likely to allow an unauthorised user access to your 

computer. 

Once you have signed in the settings that you have selected will be saved automatically until you 

decide if you would like to change them.  

In order to change the settings of signing in simply open the application, select the sign out button, 

select the sign in button once again and proceed to fill out the  ‘Sign in’ pop up box credentials.  

If a user forgets their username or password then please contact the FIVB VIS administrator. 
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2.4 Updates  
The FIVB VIS application will automatically request for an update of the software when applicable.  It 

is recommended to update the software when available. 

Upon opening the application, a pop up box with the updates will appear (if there is any). At this 

stage you can accept and run the updates to keep your software up to date. 

 

A user can change the automatic installation process by 

 Select the ‘File’ tab  

 Select ‘Options’ from the side panel 

 Select ‘Update’ 

 From the ‘Frequency’ box a user can select how the application will search for 

updates 
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2.5 Uninstall 
To uninstall the FIVB VIS application proceed with the following steps: 

 Select Programs and Features from the Windows control panel  

 Right click on item (FIVB VIS) and select ‘uninstall’ 

 Select the ‘Confirm’ button on the FIVB Application pop up box 

The application will be removed from your computer but please note that some data may be left 

behind on your computer. Therefore, if you reinstall the application to the same computer then you 

may have some saved information from your previous sessions appear.  
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RIBBON 

3. Navigation Ribbon  
The default page upon opening the FIVB VIS application is the ‘Menu’ tab. The other tab available is 

‘File’.  

Some of the icons will appear in a greyed out form which means that they are not active within a 

certain area of the application. Different features of the application will become active depending on 

the area that a user is navigating within the application.  

Within the ‘Navigation Ribbon’ can be split into three main categories as seen below in the image. 

 

3.1 File tab 
The ‘File’ tab is similar to that of Microsoft programs. Here a user can expand a side menu bar to 

access different features within the application. 

 Close – returns the user to the default home page 

 Recent – List of recent events visited 

 Options – Users can access the following features  

o Folders – Allocate the FIVB VIS application to a folder on a computer 

o Languages – Select between current application languages 

o Update – Here a user can change the update settings for the application 

o Web Service – Complete and check web based information for the application 

o WebService log – View web service log data 

 About VIS – Provides information on the FIVB VIS application 

 Exit – Closes the application 
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3.2 Main tab 
The ‘Main’ tab allows a user to enter into a competition for Volleyball or Beach volleyball by selecting 

the relevant icon in the tool bar drop down menu (as seen below). 

 

3.3 Events – Volley and Beach 
Each icon in this section will enable a user to select from a variety of Volleyball or Beach Volleyball 

events from a new window that will pop up once an icon has been clicked on.  

The FIVB VIS application has been designed to function in a similar way to Microsoft. Users my find 

and related to the application due to the layout and navigation.  

3.4 Persons - Players 
Selecting the ‘New Player’ icon will enable a user to view a list of athletes from both disciplines of 

the sport. Once again, a new window will appear once the icon is selected enabling the user to 

interact with the feature.  

Here a user can also add a new player to the system by selecting the ‘New Player’ icon located in the 

drop down tool bar.  

Please note: this is dependent upon user access rights. 
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3.5 Edit  
In this section a user will find the following feature: 

 Modify 

 Accept  

 Cancel 

 

 

3.5.1 Modify 

A user can modify data when a user is signed in tot eh FIVB VIS application. This functionality is based 

on user access rights, roles and permissions.  

Modification to data is dependent upon the user access rights. In order to access this feature, you 

must have an active user account. If you do not then this feature will not be active and will appear 

‘greyed’ out.  

This feature is presented in the main tool menu bar at all times however it is only active in certain 

areas of the application.  

If the feature is greyed out then this indicates that it is inactive.  

3.5.2 Accept 

Selecting the ‘Accept’ button will save any changes that the user has made to a section of the FIVB 

VIS application. 

Please note: accepting to save edited or updated data will result in all users of the FIVB VIS 

application be able to see these changes.  

3.5.3 Cancel 

Selecting the ‘Cancel’ button will delete any edited or updated data entered into the FIVB VIS 

application from that particular section the user was operating in.  
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4. Volleyball - Events 
In this feature a user will be able to view a variety of Volleyball events from a pop up window titled 

‘Open a volleyball tournament’ window as seen below. 

The data presented functions in a similar way to Microsoft Excel whereby data is within cells and can 

be listed or filtered according to the users’ needs. Interact with this data by double clicking on any 

line item. 

 

 

Once a user has selected an event it will be saved as a recent item in the ‘Volleyball’ icon drop down 

menu. This can also be accessed via the ‘File’ tab. 
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Selecting an event from the ‘Volleyball’ icon drop down will open a pop up window similar to the 

image below. In this view the user will have a new set of feature icons as shown in the image above. 

Note, the main navigation bar has an additional tab called ‘Volleyball’ and in the main window of the 

pop up there is content relating to ‘Matches’ from the previous line item selected at the ‘Open 

Volleyball tournament’ window. 

 

4.1 Reports - Tournament 
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4.2 Teams 
 

4.2.1 List icon 

 

The ‘List’ icon in the ‘Teams’ section will open a new tab in the main window of the application 

presenting data of teams entered for that the specific event that the user has selected.  

 

 

 

 

 

. 

 

 

A user can double click on any team and navigate to another tab containing the team information 

(Players, Officials and Honours) related to that specific team in the specific tournament.  
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4.1.1 Reports 

A team report can be generated to provide the user with a document containing a variety of 

information about a team such as the player’s names, birthdays, weight, height and the club that the 

player plays for.  

It is possible to generate a report for one team or multiple teams (as displayed below). To select 

multiple teams first select a team and then hold down the control button (Ctrl) on  your keyboard 

and continue to select other teams. 

Select the ‘Reports’ icon from the drop down meu bar and select ‘Composition for selected team(s)’. 

 

A report similar to the image below will be generated.  

Here a user can print the report or select the ‘export’ icon (this looks like a floppy disk drive or the 

save function in Windows) to a variety of different formats 
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4.3 Referees  

4.3.1 List 

The referee list will display a list of the referees assigned to the specific event selected. 

Filtering options are available. 

 

 

 

 

4.4 Pools  
In this section a user will find the following feature: 

 List 

4.4.1 List Icon 

The ‘List’ icon in the ‘Pools’ section will display the pools and tournament structure for the specific 

event selected. 

Filtering options are available. 
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4.5 Matches 
In this section a user will find the following feature: 

 List 

 Reports  

 

4.5.1 List 

This view presents the list of matches for a particular event selected. The match list can be sorted, 

filtered and grouped in various ways.  

 

Double on a line item to go into the details of a match. Here a user will have a variety of options to 

enter or edit data. Please note that in some fields a user may have to select the ‘Modify’ icon in the 

main tool bar menu.  
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4.5.2 Reports 

 

To create a match report a user can select a match from the matches section and then select the 

‘Reports’ icon followed by ‘P-2 (match result) for selected match’.  

 

 

 

 

 

 

 

A report will be generated in a new pop up window whereby a user can interact with it in a similar 

fashion to other reports generated by the application. 
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4.6 Edit  
In this section a user will find the following feature: 

 Modify 

 Accept  

 Cancel 

 

 

4.6.1 Modify 

A user can modify data when a user is signed in tot eh FIVB VIS application. This functionality is based 

on user access rights, roles and permissions.  

This feature is presented in the main tool menu bar at all times however it is only active in certain 

areas of the application.  

If the feature is greyed out then this indicates that it is inactive.  

4.6.2 Accept 

Selecting the ‘Accept’ button will save any changes that the user has made to a section of the FIVB 

VIS application. 

Please note: accepting to save edited or updated data will result in all users of the FIVB VIS 

application be able to see these changes.  

4.6.3 Cancel 
Selecting the ‘Cancel’ button will delete any edited or updated data entered into the FIVB VIS 

application from that particular section the user was operating in.  
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5. Beach feature 
Selecting the ‘Beach’ icon in the ‘Navigation Ribbon’ will enable a user to view a variety of Beach 

Volleyball events from a pop up window titled ‘Open a beach tournament’ as seen below. 

The data presented in the grid view functions in a similar way to Microsoft Excel. Within this view 

data can be listed or filtered according to the user’s needs.  

To view more information on a specific event, double click on any line item to open a new tab 

specifically for that event.  

Please Note: The following information provided in the ‘Beach’ section is entirely related to the 

Beach volleyball discipline. Therefore, matches, players and referees in this section are associated to 

Beach Volleyball.  
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Once a user has selected an event they can quickly access it again from the drop down menu 

presented by selecting the icon beneath the ‘Beach’.  

 

5.1 Beach Volleyball Tab 
Once an event has been selected a new tab labelled ‘Beach volleyball’ will be located on the 

navigational Ribbon. In this view users will have specific features available to them for the use of 

beach volleyball. 

Key functionality available within the ‘Navigational Ribbon’; 

Event 

 Data: presents event data such as court allocation for a specific event 

 Referees: presents information on referees for a specific events 

 Matches: presents information on all gender matches at an event (male and female) 

Tournament 

 Data: presents information on the format and status of a tournament 

 Refresh: updates the application data 

 Reports: provides the user with multiple tournament report formats 

 Tools: allows users to reset and calculate rankings (depending on access rights) 

Teams 

 List: provides a list of the teams entered for a specific event 

 Tools: provides users with a variety of tools to edit team data (depending on access rights) 

 

Rounds 

 List: provides a list of the event rounds and highlights the competition format 
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 Tools: enables a user to calculate a ranking for each pool of the tournament 

Matches 

 List: provides a list of matches specific to the specific event selected (male or female) 

 Reports: generate reports such as match schedules or score sheets for specific matches 

 Tools: provides users with a variety of tools to edit match data (depending on access rights) 

 



FIVB VIS Volleyball Information System 

 

26 

5.2 Event  
In this section a user will find the following features: 

 Data 

 Referees 

 Matches  

 

5.2.1 Data 
The ‘Data’ icon in the ‘Event’ section will display data related to the city, venue, event, court and 

other information coming soon. 

 

5.2.2 Referees 

 

The ‘Referees’ icon in the ‘Events’ section will display the referees registered for the specific event 

selected.  

Filtering options in the grid list are available.  
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5.2.3 Matches  

The ‘Matches’ icon in the ‘Event’ section will display all matches related to an event. This means that 

both Male and Female matches will be displayed if available.  

Filtering options are available.  

 

 

Double clicking on an event match will open a new tab in the main window will editing functions for 

the match Information and Result.  
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5.3 Tournament  
In this section a user will find the following features: 

 Data 

 Refresh 

 Reports 

 Tools 

5.3.1 Data 
In this section a user will be able to see information in the ‘Format’ and ‘Status’ tabs. The ‘Format’ 

tab will be displayed in the main window of the application. A user will be able to view existing data 

in the fields provided when navigating in both the ‘Format’ and ‘Status’ tabs.  

Depending on user access rights, the ‘Modify’ button in the ‘Edit’ section of the main tool bar might 

be active in which case a user can select this to enter or edit the fields in both tabs. When finished, 

select the ‘Accept’ icon next to the ‘Modify’ icon. To cancel the changes select the ‘Cancel’ icon. 
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5.3.2 Refresh 

Selecting the ‘Refresh’ button will send a request from the application to the server for an update of 

content.  

The information will be amended automatically if there are any changes. 

 

5.3.3 Reports 

The ‘Tournaments Report’ feature can provide a user with a variety of reports as seen from the 

image below. 

Each report generated in the FIVB VIS application can be printed by using the print icon (outlined in 

the following images). Alternatively, users can export the report in a variety of formats such as a PDF 

file, CSV, Excel, Rich Text Format, TIFF file and Web Archive.  

The report options will be outlined in the following sections. 
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Report Types: 

5.3.3.1 Participating teams  

 

 Qualification process 

This report collects data based on a team’s qualification process for a specific event.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Main draw 

This report generates the participating team of the main draw tournament including seeding 

and technical points. 

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.2 Signature sheet 

 Reserve teams  

This report generates a list of the reserve teams entered for a specific event.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Qualification  

This report generates a list of the qualification statistics relevant to a specific event.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Main draw  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.3 Round rankings  

 

This report generates information on team rankings for a specific tournament. Here a user 

will see data such as the points for each team in a specific event tournament. 

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.4 Match Schedule 

 Qualification tournament  

This report will generate the match schedule for the qualification rounds specific to a 

particular tournament.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Main draw  

This report will generate the match schedule for a specific event tournament. 

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.5 Match Results 

 Qualification tournament  

This report will generate the match results for the qualification rounds specific to a particular 

tournament.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Main draw  

This report will generate the match results for a specific event tournament. 

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.6 Ranking 

 Qualification tournament … 

This report will generate the ranking results for the qualification rounds specific to a 

particular tournament.  

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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 Main draw  

This report will generate the ranking results for a specific event tournament. 

 

Each report generated in the FIVB VIS application can be printed once a report is created by 

using the print icon and each report can be exported in a variety of formats using the floppy 

disk icon. 
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5.3.3.7 Bulletin cover page 

 

This report will ask the user which daily bulletin should be generated on a specific date. Once 

selected and generated, the user will be able to identify the speciffic bulletin associated to a speciffic 

day of a tournament. 
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5.4 Tournament – Tools 
In this section a user will find the following features: 

 Reset 

 Calculate ranking 

 

5.4.1 Reset 

 

 Limited user access rights to this section  

 If a user has access they must be extremely cautious when using this feature because it will 

delete the match schedule and results already entered. If this occurs then the event data will 

be reset to the registration state. 

 

 

5.4.2 Calculate ranking … 

 

Select the ‘Calculate ranking’ button from the ‘Tools’ menu to calculate the tournament ranking 

based on the match results.  
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5.5 Teams  
 

In this section a user will find the following features: 

 List 

 Tools 

5.5.1 List  

This view displays a list of the teams entered for a specific competition. As seen in the image below 

there is a variety of tabs in the main window of the application available to the user.  

 

 

The tabs available in this feature will vary from each event, particularly with regards to the quota 

tabs.   

In either tab available in the main window of the application (as mentioned above) the user can 

double click on a line item in the grid view to go deeper into that specific piece of data. 

Double click on a team to proceed to an individual team ta. Here a user can modify data when a team 

is playing in the Main Draw or Qualification Tournament depending on the team’s progress in the 

event. 
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Depending on user access rights, the user will have limited functionality in this space. Each user will 

have access only at the base level and other may be able to modify data   
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5.5.2 Tools 

There are more options available within this function however access to the ‘Tools’ icon is only 

accessible for specific user access rights. 

 

 Calculate entry points … 

The entry point calculated at the entry reference data for the tournament can be found in 

the Tournament data section.  

 

To do this, select a team from the list of teams available.  

 

 Dispatch teams … 

Dispatching teams allocates teams to relevant tournaments (main draw, reserve, etc) when 

there is an over subscription to a tournament.  

 

 Calculate seed points … 

The seed point calculated at the entry reference data for the tournament can be found in the 

Tournament data section.  

 

To do this, select a team from the list of teams available.  

 

 Reorder teams 

The reorder function allows a user to manually change the order of teams within 

tournaments (Country quotas, Qualification tournament and Main draw). This works on a 

drag and drop basis.  

 

User can also select the ‘Order by points’ button to re-order teams within that list. This will 

reorder teams based on the highest points first. Please note that this does not allow user to 

enter or edit team points into the application.  

 

Select the ‘Ok’ button to save any changes that have been made. To resort back to the 

original order, select the ‘Reorder’ button and then ‘Order by points’.  
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5.6 Rounds  
In this section a user will find the following features: 

 List 

 Tools 

 

5.6.1 List 

This view presents the rounds for the tournament.  

Double click on a round for further information.  

 

 

 

 

 

5.6.2 Tools 
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This feature enables users to calculate ranking by pools within a specific tournament. The pools 

available will vary form event-to-event. 
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5.7 Matches 
In this section a user will find the following features: 

 List 

 Reports 

 Tools 

 

5.7.1 List 

This feature will present a list of all the matches for a particular event. 

Double click a line item to see the Information and Results tabs of a specific match.  
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5.7.2 Reports 

To view a report, first select a match by double clicking on a line item in the Matches – List. 

Select the ‘Report’ icon to generate a report for  

 Match schedule for selected match(es) … 

 Scoresheets(s) for selected match(es) … 

It is possible to generate a report for multiple matches. To do this, hold the Ctrl (control) button and 

select matches by left clicking on line items. 

 

 

 

5.7.3 Tools 

 

In this section a user will be able to load tournament format from the library. The most used Beach 

formats are available such as single elimination, 32 teams, double elimination, round robin etc. 

If the format needed is missing please contact the FIVB VIS department. 
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6. FAQ 
 

(Coming soon) 

 

7. Glossary 
(Coming soon) 

 


